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Notes on Site Usage and Cookies

= Notes on Site Usage
= How to Print

Notes on Site Usage

 Five years after a product is discontinued, its setup file is made unavailable.
The Online Manual remains available, but as a rule it is not updated.
* When viewing this site, note the following:

o For best results, enable JavaScript in your browser settings.

o To display web pages tailored to your environment, Canon may send one or more cookies to your
computer, smartphone, or tablet. Most browsers automatically accept cookies, but you can modify
your browser setting so as not to accept cookies. If you have set not to accept cookies, some of
the functions of this website may be inoperative.

o If you are using Compatibility Mode in Internet Explorer 8, some pages may not be displayed
correctly.

In this case, turn off Compatibility Mode.

» Reproduction, diversion or copying of any text, photo or image published in this site, in whole or in
part, is prohibited.

* In principle, Canon shall change or delete the contents of this site without prior notice to customers. In
addition, Canon may suspend or stop the disclosure of this site due to unavoidable reasons. Canon
shall not be liable for any damage suffered by customers as a result of changes in or deletion of
information in this site, or suspension/stoppage of disclosure of this guide.

» Although the contents of this site have been prepared with utmost care, please contact the service
center if you find any incorrect or missing information.

* In principle, the descriptions in this site are based on the product at the time of its initial sale.

* This site does not disclose the manuals of all the products sold by Canon. See the manual supplied
with the product when using a product that is not described in this site.

How to Print

Use the print function of your Web browser to print this site.

For Windows:

To set to print background colors and images, follow the steps below.

»» Note

* In Windows 8, print in the desktop version.

* In Internet Explorer 9, 10, or 11

1. Select £S3 (Tools) > Print > Page setup....
2. Select the Print Background Colors and Images checkbox.

* In Internet Explorer 8

1. Press the Alt key to display the menus.

Alternatively, from Tools, select Toolbars > Menu Bar to display the menus.
2. Select Page Setup... from the File menu.
3. Select the Print Background Colors and Images checkbox.
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* In Mozilla Firefox

1. Select = (Menu) > Print > Page Setup....
2. Select the Print Background (colors & images) checkbox in Format & Options.

* In Google Chrome

1. Select = (Chrome Menu) > Print....
2. Select the Background graphics checkbox in Options.

For Mac OS:

To print background colors and images, follow the steps below to display the Print dialog options, then
select the Print backgrounds checkbox.

1. Click Print... from the File menu.

[v]

2. Click Show Details or . (Down Arrow).
3. Select Safari from the pop-up menu.

Safari H

Print backgrounds
Print headers and footers
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Using This Online Manual

= Symbols Used in This Document
= Touch-enabled Device Users (Windows)

Symbols Used in This Document

A\ Warning
Instructions that, if ignored, could result in death or serious personal injury caused by incorrect
operation of the equipment. These must be observed for safe operation.

/A Caution
Instructions that, if ignored, could result in personal injury or material damage caused by incorrect
operation of the equipment. These must be observed for safe operation.

32 Important
Instructions including important information. To avoid damage and injury or improper use of the
product, be sure to read these indications.

»>» Note

Instructions including notes for operation and additional explanations.

Instructions explaining basic operations of your product.

»>» Note

* Icons may vary depending on your product.

Touch-enabled Device Users (Windows)

For touch actions, you need to replace "right-click" in this document with the action set on the operating
system. For example, if the action is set to "press and hold" on your operating system, replace "right-click"
with "press and hold."
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Trademarks and Licenses

» Microsoft is a registered trademark of Microsoft Corporation.

» Windows is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or other
countries.

* Windows Vista is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or other
countries.

* Internet Explorer is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or
other countries.

* Mac, Mac OS, AirPort, Safari, Bonjour, iPad, iPhone and iPod touch are trademarks of Apple Inc.,
registered in the U.S. and other countries. App Store, AirPrint and the AirPrint logo are trademarks of
Apple Inc.

+ 10S is a trademark or registered trademark of Cisco in the U.S. and other countries and is used under
license.

» Google Cloud Print, Google Chrome, Chrome OS, Chromebook, Android, Google Play and Picasa are
either registered trademarks or trademarks of Google Inc.

» Adobe, Flash, Photoshop, Photoshop Elements, Lightroom, Adobe RGB and Adobe RGB (1998) are
either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or
other countries.

» Bluetooth is a trademark of Bluetooth SIG, Inc., U.S.A. and licensed to Canon Inc.

»>» Note

» The formal name of Windows Vista is Microsoft Windows Vista operating system.

Copyright (c) 2003-2004, Apple Computer, Inc. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution.

3. Neither the name of Apple Computer, Inc. ("Apple") nor the names of its contributors may be used to
endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY APPLE AND ITS CONTRIBUTORS "AS IS" AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL APPLE OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF
THE POSSIBILITY OF SUCH DAMAGE.

Apache License
Version 2.0, January 2004

http://www.apache.org/licenses/
TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION
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1. Definitions.

"License" shall mean the terms and conditions for use, reproduction, and distribution as defined by
Sections 1 through 9 of this document.

"Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is granting
the License.

"Legal Entity" shall mean the union of the acting entity and all other entities that control, are controlled
by, or are under common control with that entity. For the purposes of this definition, "control" means
(i) the power, direct or indirect, to cause the direction or management of such entity, whether by
contract or otherwise, or (ii) ownership of fifty percent (50%) or more of the outstanding shares, or (iii)
beneficial ownership of such entity.

"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by this
License.

"Source" form shall mean the preferred form for making modifications, including but not limited to
software source code, documentation source, and configuration files.

"Object" form shall mean any form resulting from mechanical transformation or translation of a Source
form, including but not limited to compiled object code, generated documentation, and conversions to
other media types.

"Work" shall mean the work of authorship, whether in Source or Object form, made available under
the License, as indicated by a copyright notice that is included in or attached to the work (an example
is provided in the Appendix below).

"Derivative Works" shall mean any work, whether in Source or Object form, that is based on (or
derived from) the Work and for which the editorial revisions, annotations, elaborations, or other
modifications represent, as a whole, an original work of authorship. For the purposes of this License,
Derivative Works shall not include works that remain separable from, or merely link (or bind by name)
to the interfaces of, the Work and Derivative Works thereof.

"Contribution" shall mean any work of authorship, including the original version of the Work and any
modifications or additions to that Work or Derivative Works thereof, that is intentionally submitted to
Licensor for inclusion in the Work by the copyright owner or by an individual or Legal Entity
authorized to submit on behalf of the copyright owner. For the purposes of this definition, "submitted"
means any form of electronic, verbal, or written communication sent to the Licensor or its
representatives, including but not limited to communication on electronic mailing lists, source code
control systems, and issue tracking systems that are managed by, or on behalf of, the Licensor for
the purpose of discussing and improving the Work, but excluding communication that is
conspicuously marked or otherwise designated in writing by the copyright owner as "Not a
Contribution."

"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a Contribution
has been received by Licensor and subsequently incorporated within the Work.

2. Grant of Copyright License. Subject to the terms and conditions of this License, each Contributor
hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable
copyright license to reproduce, prepare Derivative Works of, publicly display, publicly perform,
sublicense, and distribute the Work and such Derivative Works in Source or Object form.

3. Grant of Patent License. Subject to the terms and conditions of this License, each Contributor hereby
grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable (except as
stated in this section) patent license to make, have made, use, offer to sell, sell, import, and
otherwise transfer the Work, where such license applies only to those patent claims licensable by
such Contributor that are necessarily infringed by their Contribution(s) alone or by combination of
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their Contribution(s) with the Work to which such Contribution(s) was submitted. If You institute patent
litigation against any entity (including a cross-claim or counterclaim in a lawsuit) alleging that the
Work or a Contribution incorporated within the Work constitutes direct or contributory patent
infringement, then any patent licenses granted to You under this License for that Work shall terminate
as of the date such litigation is filed.

. Redistribution. You may reproduce and distribute copies of the Work or Derivative Works thereof in
any medium, with or without modifications, and in Source or Object form, provided that You meet the
following conditions:

1. You must give any other recipients of the Work or Derivative Works a copy of this License; and

2. You must cause any modified files to carry prominent notices stating that You changed the files;
and

3. You must retain, in the Source form of any Derivative Works that You distribute, all copyright,
patent, trademark, and attribution notices from the Source form of the Work, excluding those
notices that do not pertain to any part of the Derivative Works; and

4. If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative Works that
You distribute must include a readable copy of the attribution notices contained within such
NOTICE file, excluding those notices that do not pertain to any part of the Derivative Works, in at
least one of the following places: within a NOTICE text file distributed as part of the Derivative
Works; within the Source form or documentation, if provided along with the Derivative Works; or,
within a display generated by the Derivative Works, if and wherever such third-party notices
normally appear. The contents of the NOTICE file are for informational purposes only and do not
modify the License. You may add Your own attribution notices within Derivative Works that You
distribute, alongside or as an addendum to the NOTICE text from the Work, provided that such
additional attribution notices cannot be construed as modifying the License.

You may add Your own copyright statement to Your modifications and may provide additional or

different license terms and conditions for use, reproduction, or distribution of Your modifications,

or for any such Derivative Works as a whole, provided Your use, reproduction, and distribution of
the Work otherwise complies with the conditions stated in this License.

. Submission of Contributions. Unless You explicitly state otherwise, any Contribution intentionally
submitted for inclusion in the Work by You to the Licensor shall be under the terms and conditions of
this License, without any additional terms or conditions. Notwithstanding the above, nothing herein
shall supersede or modify the terms of any separate license agreement you may have executed with
Licensor regarding such Contributions.

. Trademarks. This License does not grant permission to use the trade names, trademarks, service
marks, or product names of the Licensor, except as required for reasonable and customary use in
describing the origin of the Work and reproducing the content of the NOTICE file.

. Disclaimer of Warranty. Unless required by applicable law or agreed to in writing, Licensor provides
the Work (and each Contributor provides its Contributions) on an "AS I1S" BASIS, WITHOUT
WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied, including, without
limitation, any warranties or conditions of TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or
FITNESS FOR A PARTICULAR PURPOSE. You are solely responsible for determining the
appropriateness of using or redistributing the Work and assume any risks associated with Your
exercise of permissions under this License.

. Limitation of Liability. In no event and under no legal theory, whether in tort (including negligence),
contract, or otherwise, unless required by applicable law (such as deliberate and grossly negligent
acts) or agreed to in writing, shall any Contributor be liable to You for damages, including any direct,
indirect, special, incidental, or consequential damages of any character arising as a result of this
License or out of the use or inability to use the Work (including but not limited to damages for loss of
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goodwill, work stoppage, computer failure or malfunction, or any and all other commercial damages
or losses), even if such Contributor has been advised of the possibility of such damages.

9. Accepting Warranty or Additional Liability. While redistributing the Work or Derivative Works thereof,
You may choose to offer, and charge a fee for, acceptance of support, warranty, indemnity, or other
liability obligations and/or rights consistent with this License. However, in accepting such obligations,
You may act only on Your own behalf and on Your sole responsibility, not on behalf of any other
Contributor, and only if You agree to indemnify, defend, and hold each Contributor harmless for any
liability incurred by, or claims asserted against, such Contributor by reason of your accepting any
such warranty or additional liability.

END OF TERMS AND CONDITIONS

The following applies only to products supporting Wi-Fi.
(c) 2009-2013 by Jeff Mott. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions, and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions, and the
following disclaimer in the documentation or other materials provided with the distribution.

* Neither the name CryptoJS nor the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS,"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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Enter keywords in the search window and click E (Search).

You can search for target pages in this guide.

Entry example: "(your product's model name) load paper"

Search Tips

You can search for target pages by entering keywords in the search window.

Canon

Contents | * Mobes on Site Usage and Cockies

Online Manual

- series -

E Satup | E Change Preduct |

) Featured Topics

3% Important

This function may not be available in some countries/regions.

»» Note

The displayed screen may vary.
When searching from this page without entering your product's model name or your application's name,
all products supported by this guide will be considered for the search.

If you want to narrow down the search results, add your product's model name or your application's
name to the keywords.

Searching for Functions

Enter your product's model name and a keyword for the function you want to learn about
Example: When you want to learn how to load paper

Enter "(your product's model name) load paper" in the search window and perform a search
Troubleshooting Errors

Enter your product's model name and a support code

Example: When the following error screen appears
Enter "(your product's model name) 1003" in the search window and perform a search
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»» Note

» The displayed screen varies depending on your product.

» Searching for Application Functions
Enter your application's name and a keyword for the function you want to learn about
Example: When you want to learn how to print collages with My Image Garden
Enter "My Image Garden collage" in the search window and perform a search

» Searching for Reference Pages

Enter your model name and a reference page title*
* You can find reference pages more easily by entering the function name as well.

Example: When you want to browse the page referred to by the following sentence on a scanning
procedure page

Refer to "Color Settings Tab" for your model from Home of the Online Manual for details.

Enter "(your product's model name) scan Color Settings Tab" in the search window and perform a
search
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Using the Machine
» Printing Photos from a Computer

» Copying Originals
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Printing Photos from a Computer

This section describes how to print photos with My Image Garden.

This section uses windows displayed when the Windows 8.1 operating system (hereinafter referred to as
Windows 8.1) is used.

1. Open the front cover (A).
2. Extend the paper support (B).

3. Load paper vertically WITH THE PRINT SIDE FACING DOWN.

Push the paper stack all the way to the back of the front tray.

G

4. Align the paper guides with the paper width.

5. Open the output tray extension (C).

6. Open the paper output tray (D).

7. Extend the paper output support (E).



8. Click the My Image Garden icon (F) in Quick Menu.

The Guide Menu screen is displayed.

- EURGE-L R0

> Note

* The number and types of icons displayed vary depending on your region, the registered printer/
scanner and the installed applications.

9. Click the Photo Print icon (G).

10. Click the folder (H) with photos you want to print.
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11. Click the photos (I) you want to print.

For Windows:

To select two or more photos at a time, click photos while pressing the Ctrl key.

For Mac OS:

To select two or more photos at a time, click photos while pressing the command key.

12. Click Print (J).

13. Specify the number of copies, your machine name, media type, etc. (K).

14. Click Print (L).

For Mac OS:

Click OK when the confirmation message appears, then click Print.

»» Note

* My Image Garden lets you use images on your computer, such as photos taken with a digital camera, in
a number of ways.

= My Image Garden Guide (Windows)
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= My Image Garden Guide (Mac OS)
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Copying Originals

This section describes how to load originals and copy them to plain paper.
1. Open the front cover (A).
2. Extend the paper support (B).

3. Load paper vertically WITH THE PRINT SIDE FACING DOWN.

Push the paper stack all the way to the back of the front tray.

e

4. Align the paper guides with the paper width.

5. Open the output tray extension (C).

6. Open the paper output tray (D).

7. Extend the paper output support (E).



8. Open the document cover (F).

9. Load the original WITH THE SIDE TO COPY FACING DOWN and align it with the

alignment mark (G).

10. Close the document cover gently.

G F

11. Press the Paper button (H) to light the upper Paper lamp (1).

12. Press the Black button or Color button (J).

22 Important

* Do not open the document cover until copying is complete.
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»» Note

» For details on copy features, see Copying.
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Printer Functions
» Connect Wirelessly with Ease in "Access Point Mode™
» Print Photos Easily Using My Image Garden
» Download a Variety of Content Materials
» Print Items with Easy-PhotoPrint+ (Web Application)
» Available Connection Methods
» Easy Scan with the Auto Function
» Scan Originals Larger than the Platen
» Scan Multiple Originals at One Time
» Using PIXMA/MAXIFY Cloud Link
» Print Easily from a Smartphone or Tablet with Canon PRINT Inkjet/SELPHY
» Printing with Windows RT

» Checking Printer Information
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Connect Wirelessly with Ease in "Access Point Mode™

The machine supports "access point mode" in which you can connect to the machine wirelessly from a
computer or smartphone even in an environment without an access point (wireless router).

Switch to "access point mode" with simple steps to enjoy scanning and printing wirelessly.

When you use the machine with the access point mode, be sure to specify the access point name (SSID) of
the machine and the security setting in advance.

= Using Machine with Access Point Mode
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Print Photos Easily Using My Image Garden

Organize Images Easily

In My Image Garden, you can register the names of people and events to photos.
You can organize photos easily as you can display them not only by folder but also by calendar, event,
and person. This also allows you to find the target photos easily when you search for them later on.

<Calendar View>

Display Recommended Items in Slide Shows

Based on the information registered to photos, Quick Menu automatically selects the photos on your
computer and creates recommended items such as collages and cards. The created items appear in slide
shows.

If there is an item you like, you can easily print it in just two steps.

1. In Image Display of Quick Menu, select the item you want to print.
2. Print the item with My Image Garden.
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Place Photos Automatically

Delightful items are created easily as the selected photos are placed automatically according to the
theme.

Other Various Functions

My Image Garden has many other useful functions.
Refer to the following for details.

= \What You Can Do with My Image Garden (Windows)
= \What You Can Do with My Image Garden (Mac OS)
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Download a Variety of Content Materials

CREATIVE PARK

A "printing materials site" where you can download all the printing materials for free.

Various types of content such as seasonal cards and paper crafts that can be made by assembling paper
parts are provided.

It is easily accessible from Quick Menu.

CREATIVE PARK PREMIUM

A service where customers using models that support PREMIUM Contents can download exclusive
printing materials.

PREMIUM Contents can be downloaded easily via My Image Garden or Easy-PhotoPrint+. Downloaded
PREMIUM Contents can be printed directly with My Image Garden or Easy-PhotoPrint+.

To download PREMIUM Contents, make sure that genuine Canon ink tanks/ink cartridges are installed for
all colors on a supported printer.

> Note

» The designs of PREMIUM Contents provided in this page are subject to change without prior notice.
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Print Items with Easy-PhotoPrint+ (Web Application)

You can easily create and print personalized items such as calendars and collages, anytime and anywhere,
by simply accessing Easy-PhotoPrint+ on the web from a computer or tablet.

By using Easy-PhotoPrint+, you can create items in the latest environment without going through the trouble
of installation.

Moreover, you can use various photos for your item through integration with social networks such as
Facebook, or with online storage, web albums, etc.

Refer to "Easy-PhotoPrint+ Guide" for details.
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Available Connection Methods

The following connection methods are available on the machine.

(tp)

Wireless Connection

* With a wireless router

g,

* Without a wireless router

g,
&'®

s

USB Connection

o™

Wireless Connection

There are two methods for connecting the printer to your device (such as a smartphone). One method is
to connect using a wireless router, and the other method is to connect without using a wireless router.

The two connection methods cannot be used at the same time.

If you have a wireless router, we recommend you use the method described in Connection Using a
Wireless Router.

When connecting another device while a device is already connected to the printer, connect it using the
same connection method as the connected device.

If you connect using a different connection method, the connection to the device in use will be disabled.

» Connection Using a Wireless Router

G,

o Connect the printer and a device using a wireless router.

o Connection methods vary depending on the wireless router type.
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—
o When the connection between a device and a wireless router is completed and = (Wi-Fiicon)is
displayed in the device's screen, you can connect the device to the printer using the wireless
router.

» Connection without Using a Wireless Router

¥

o Connect the printer and a device without using a wireless router. Connect a device and the printer
directly using the printer's access point mode function.

o When establishing a connection in the access point mode, Internet connection may become
unavailable. In that case, web services for the printer cannot be used.

o If you connect a device connected to the Internet via a wireless router to the printer that is in the
access point mode, the connection between the device and wireless router will be disabled. In
that case, the connection of the device may switch to a mobile data connection automatically
depending on your device. Transmission fees for connecting to the Internet using a mobile data
connection apply.

o In the access point mode, you can connect up to five devices at the same time. If you try to
connect a sixth device while five devices are already connected, an error will appear. If an error
appears, disconnect one of the connected device you do not use and configure settings again.

When Using Windows XP:

Direct Connection (Windows XP)

USB Connection

Connect the printer and a computer with a USB cable. Prepare a USB cable.

Restrictions

(Appears in a new window)
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Direct Connection (Windows XP)

Restrictions

(Appears in a new window)

1. If the Wi-Fi lamp (A) on the printer is flashing, press the Stop button (B).

a a B

=
“ae

2. Press and hold the Wi-Fi button (C) on the printer until the ON lamp (D) flashes.

(D) '13

[ (C)

9 o(w) ~
B G/ A
&= =

Check the SSID and network key of your printer.

The default SSID is the printer name, and the default Password (Network key) is the serial number of the
printer. Check the rear side of the printer or warranty.

If the SSID/Password (Network key) are unknown, print the LAN setting information and check the SSID/
Password (Network key) field.

* How to print the LAN setting information
Press the Wi-Fi button on the printer. The LAN setting information will be printed.

If you printed the LAN setting information, repeat step 2 before proceeding to step 3.

3. Press the Color button (E) then the Black button (F).

The printer's Direct Connection will be enabled.

4. Right-click the Wireless Network Connection icon in the notification area of the taskbar on
the computer, then select View Available Wireless Networks.

Charge Windows Firewal settings
Cypen Mabwark Connedtions

Fe
|'||ilu|||mI Awailable Wireless Networks I

5. Select the network name (SSID) you want to use, then click Connect.
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7. When connection is complete, click Back until the screen below appears.
Proceed with the setup.

Start Setup

Starting the satug rescid 1o uss the machins fom the computer.
Follow th regcrasn m1rutons
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Restrictions

When connecting another device while a device (such as a smartphone) is already connected to the printer,
connect it using the same connection method as the connected device.
If you connect using a different connection method, the connection to the device in use will be disabled.

Connection Using a Wired Network cannot be performed on printers that do not support a wired connection.

Connect via wireless router

You cannot establish a printer with wireless and wired connections at the same time.

Make sure your device and the wireless router are connected. For details on checking these settings,
see the manual supplied with the wireless router or contact its manufacturer.

As for a device already connected to the printer without using a wireless router, reconnect it via a
wireless router.

Configuration, router functions, setup procedures and security settings of network devices vary
depending on the system environment. For details, see the manual for your network device or contact
its manufacturer.

Check if your device supports IEEE802.11n (2.4 GHz), IEEE802.11g or IEEE802.11b.

If your device is set to the "IEEE802.11n only" mode, WEP or TKIP cannot be used as a security
protocol. Change the security protocol for your device to something other than WEP and TKIP or
change the setting to something other than "IEEE802.11n only."

The connection between your device and the wireless router will be temporarily disabled while the
setting is changed. Do not proceed to the next screen of this guide until setup is complete.

For office use, consult your network administrator.

Note that if you connect to a network with no security protection, your personal information could be
disclosed to a third party.

Direct Connection (Access Point Mode)

32 Important

If a device is connected to the Internet via a wireless router, and you then connect it to a printer in
Direct Connection mode, the existing connection between the device and wireless router will be
disabled. In that case, the connection of the device may switch to a mobile data connection
automatically depending on your device. When you connect to the Internet using a mobile data
connection, charges may apply depending on your contract.

* When you connect a device and the printer using Direct Connection, the connection information
will be saved to Wi-Fi settings. The device may be connected to the printer automatically even
after disconnecting it or connecting it to another wireless router.

* You cannot connect to a wireless router and a printer in Direct Connection mode at the same
time. If you have a wireless router, it is recommended that you use the wireless router to connect
to the printer.

» To prevent automatic connection to the printer in Direct Connection mode, change the connection
mode after using the printer, or set not to connect automatically in the Wi-Fi settings of the
device.

For details on checking or changing wireless router settings, see the wireless router manual or
contact its manufacturer.

If you connect a device and the printer using Direct Connection, Internet connection may become
unavailable depending on your environment. In that case, web services for the printer cannot be used.
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« In Direct Connection mode, you can connect up to five devices at the same time. If you try to connect
a sixth device while five devices are already connected, an error will appear.
If an error appears, disconnect a device that does not use the printer, then configure settings again.

» Devices connected to the printer using Direct Connection cannot communicate with each other.

» Firmware updates for the printer are not available while using Direct Connection.

* When a device has been connected to the printer without using a wireless router and you want to set
it up again using the same connection method, disconnect it first. Disable the connection between the
device and printer in the Wi-Fi setting screen.

Connection Using a Wired Network

* You cannot establish a printer with wireless and wired connections at the same time.
* When using a router, connect the printer and a device to the LAN side (same network segment).
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Easy Scan with the Auto Function

By using the auto function of IJ Scan Utility, you can scan easily by automatically detecting the item type.
Refer to the following for details.

= Easy Scanning with Auto Scan (Windows)

= Easy Scanning with Auto Scan (Mac OS)
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Scan Originals Larger than the Platen

By using the stitch function of IJ Scan Utility, you can scan the left and right halves of an item larger than the
platen and combine them back into one image. ltems up to approximately twice as large as the platen are
supported.

Refer to the following for details.

= Scanning Originals Larger than the Platen (Image Stitch) (Windows)
= Scanning Originals Larger than the Platen (Image Stitch) (Mac OS)

46



Scan Multiple Originals at One Time

By using IJ Scan Ultility, you can scan two or more photos (small items) placed on the platen at one time and
save each image individually.

Refer to the following for details.

= Scanning Multiple Originals at One Time (Windows)
= Scanning Multiple Originals at One Time (Mac OS)
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Using PIXMA/MAXIFY Cloud Link

By using PIXMA/MAXIFY Cloud Link, you can connect your printer to a cloud service, such as CANON
iIMAGE GATEWAY, Evernote, or Twitter, and use the following functions without using a computer:

 Print images from a photo-sharing service

* Print documents from a data management service

» Save scanned images to a data management service.

+ Use Twitter to report the printer status, such as no paper or low ink levels.

In addition, you can use various functions by adding and registering apps that are linked with various cloud

services.

= Using PIXMA/MAXIFY Cloud Link from Your Printer
= Using PIXMA/MAXIFY Cloud Link from Your Smartphone, Tablet, or Computer

32 Important

* In certain countries, PIXMA/MAXIFY Cloud Link may not be available or the available apps may be
different.

+ Some apps require that you have an account before you use those apps. For such apps, please set up
an account beforehand.

+ To find out which models support PIXMA/MAXIFY Cloud Link check the Canon homepage.

» The screen display may change without prior notice.
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Notice for Web Service Printing

When Using Web Service

Canon does not guarantee the continuity and reliability of the web services provided, the availability of
site access, or permission to download the materials.

Canon may at any time update, change, or delete the information provided through the web service,
or may suspend or discontinue the service without prior notice. Canon shall not be held responsible
for any damages resulting from such actions.

In no event shall Canon be liable for any damages whatsoever resulting from the use of the web
services.

User registration is necessary before you can use the external link site.

When you use the external link site, observe the conditions of use of the site and use the service
within your own responsibility.

All or part of the web service may not be available depending on the country or region you live in.
Depending on your network environment, some functions on web service are not available. Even if
they are available, it may take a while to print or display the contents, or communication may be
interrupted while operation is in progress.

When you use web service, your machine's name, information of your region or country, your selected
language, and what kind of service you use (e.g. photo sharing site) are sent to and saved in our
server. Canon is unable to identify specific customers using this information.

Before you transfer ownership or dispose of a printer that supports a color LCD monitor, select
Device settings -> Reset setting -> Reset all and delete your login name and password.

For details, contact a Canon-authorized sales representative in the country or region you live in.

To Those Living in Mainland China

PIXMA/MAXIFY Cloud Link, Easy-PhotoPrint+, and some functions of PIXMA/MAXIFY Printing
Solutions, which are included with this machine, are provided by Canon Inc.

However, as the server is installed outside of mainland China, some of these services may not be
available yet.

Copyrights and Rights of Publicity

When printing using a service provided by Canon

1.

2.

The copyright of each material (photos, illustrations, logos, or documents: hereinafter referred to as
"the materials") provided on the printing service belongs to their respective owners. Issues pertaining
to Rights of Publicity may arise regarding the use of any of people or characters displayed on the
printing service.

Except as otherwise permitted (please see "2" below), copying, modifying or distributing all or a
portion of any of the materials contained on the web template printing service without prior consent of
the respective rights (Rights of Publicity and Copyright) holder is strictly prohibited.

All of the materials provided on the web template printing service can be freely used for personal and
non-commercial purposes.
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Using PIXMA/MAXIFY Cloud Link from Your Printer
» Before Using PIXMA/MAXIFY Cloud Link
» Registering Printer Information to PIXMA/MAXIFY Cloud Link
» Using PIXMA/MAXIFY Cloud Link

» Cloud Troubleshooting
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Before Using PIXMA/MAXIFY Cloud Link

First, check the following content:

* Precautions

If you plan to use the web service to print documents, be sure to check these precautions beforehand.

 Printer Specifications

o The printer must support a color LCD monitor.

> Your printer may not support the scan function.

° The printer must support the Canon Inkjet Cloud Printing Center.
Some models do not support this function. To check whether your model supports this function, see
"Models that Support Canon Inkjet Cloud Printing Center".

* Network environment

The printer must be connected to a LAN and to the Internet.

If your printer is not connected to a LAN, see here and set one up.

For information on the LAN and Internet settings, see the manual of your network devices or contact the
manufacturer.

32 Important

* The user will bear the cost of Internet access.

= Registering Printer Information to PIXMA/MAXIFY Cloud Link

Copyright ¢ 1991-2015 Unicode, Inc. All rights reserved. Distributed under the Terms of Use in http://
www.unicode.org/copyright.html.

This software is based in part on the work of the Independent JPEG Group.

THE BASIC LIBRARY FUNCTIONS

Written by: Philip Hazel

Email local part: ph10

Email domain: cam.ac.uk

University of Cambridge Computing Service, Cambridge, England.
Copyright (c) 1997-2008 University of Cambridge All rights reserved.

THE "BSD" LICENCE

Redistribution and use in source and binary forms, with or without modification, are permitted provided that
the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of the University of Cambridge nor the name of Google Inc. nor the names of their
contributors may be used to endorse or promote products derived from this software without specific prior
written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND
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ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS
OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN
IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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Registering Printer Information to PIXMA/MAXIFY Cloud Link

Follow the steps described below to register the printer information to the cloud service server.

1. Check that the printer is connected to the Internet

2. From the printer home screen, select Cloud

»» Note

« If multiple users will be using the printer after the initial registration, select the login user name

from the Switch user screen, enter the Security code, and proceed with the registration.
If the Security code is incorrect, use your smartphone, tablet, or computer, and change the
setting from the My account of the Canon Inkjet Cloud Printing Center.

3. When the registration preparation completed screen appears, select OK

Ready to register with 1] Cloud
Printing Center. Follow the
on-screen instructions to
register,

4. On the confirmation screen, select Next

Make registration for using
applications.

Mext

5. In the License agreement and Privacy statement windows, read the statements, and then
select Agree if you agree

<License agreement>

Important: Please read this before
using this service

Service Terms of Use

These Service Terms of Use (the
[ [Start] Print

Do not agree Agree
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<Privacy statement>

Important: Flease read this before
using this service

Privacy Statement

This Privacy Statement {the
[ [Start] Print

Do not agree Agree

»» Note

+ If you select Do not agree, a confirmation screen asking whether you want to cancel Register My
account appears. If you select Yes, then Register My account is canceled, and you return to the
Home screen.

Even if you select Do not agree, you can still use this service by selecting Agree from the
registration screen later.

* You can print the displayed information by pressing the Start button.

6. On the Current time check screen, select the time closest to the current time, and then
select Next

You can set the time in 10-minute units.

Current time check

Select the time closest to the
current time.

0o : 0o

7. In the time zones list, select the region closest to you
For some regions, a screen for applying the daylight saving time setting may appear.

Time zone

(UTC+09:00) Tokyo
(UTC+09:30) Adelaide

(UTC+09:30) Darwin

{UTC+10:00) Brishane

The registration of printer information is completed, and a list of apps is displayed.
See here for the description of the apps list screen.

After you complete the registration, you can print photos and documents that have been uploaded to apps
on the linked cloud service and add/delete/sort apps.

= Using PIXMA/MAXIFY Cloud Link
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Application Management

This section explains how to add, delete, and sort apps.

32 Important

» Select how to manage allows you to change which users can use this service.
For details, see "Canon Inkjet Cloud Printing Center window".

Add apps

You can add your favorite apps to the printer.
Follow the steps described below to add apps.

1. From the printer home screen, select Cloud

2. On the cloud's Main screen, select Add/delete

CARROR

maze  CANON IMAGE GATEWAY

Ficasa Web Albums

E OneDrive

Add/ delete Manage

3. Select Register apps

Register apps
Delete apps
Sort

4. From the list, select the category of the app

Reaqister apps
All
Photoaraphy

Productivity

Creativity

5. From the displayed apps list, select the app that you want to register
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Register apps

lgf Creative Park

paper craft

.—| ® CREATIVE PARK PREMIUM

| Christmas card

Fraatihia Darls

Back

»» Note

+ Description of displayed icons

n : Can be used with genuine Canon ink.

6. Select Register

® CREATIVE PARK PREMIUM
greeting card

This app 1s available exclusively
to users of genuine Canon inks.
You can print various greeting

Register

The registration is completed and the app is added to the apps list.

To register another app, repeat the procedure from step 5.
To end the app registration, select Back and return to the cloud's Main screen.

3% Important

* Some apps may require a linked app account before you can use the app. If this is the case, set up
an account beforehand.

Delete apps

You can delete unnecessary apps from the apps list.
Follow the steps described below to delete apps.

1. From the printer home screen, select Cloud

2. On the cloud's Main screen, select Add/delete

maze  CANON IMAGE GATEWAY

Picasa Web Albums

E OneDrive

Add/delete Manage
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3. Select Delete apps

Register apps

Delete apps
Sort

4. From the apps list, select the app that you want to delete

Delete apps

Chbaii

wa@e  CANON iMAGE GATEWAY

Picasa Web Albums

H ® ~hCAaTIE DADY DOCEANIES
Back

»» Note

« Description of displayed icons

: Cannot be used because it is not yet released or does not support your region, model, or
language.

n : Can be used with genuine Canon ink.

5. Select Delete

Sl *® CREATIVE PARK PREMIUM
- paper craft

This app is available exclusively
to users of genuine Canon inks.
You can print various paper

Delate

When the deletion is finished, the app will be deleted from the apps list on the main screen.

To delete another app, repeat the procedure from step 4.
To end the app deletion, select Back and return to the cloud's Main screen.

»>» Note

» Config allows you to re-register deleted apps.

Sort apps

You can sort apps displayed on the apps list.
Follow the steps described below to sort apps.
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1. From the printer home screen, select Cloud

2. On the cloud's Main screen, select Add/delete

ITAROR

it CANON IMAGE GATEWAY

Picasa Web Albums

E OneDrive

Add/delete Manage

3. Select Sort

Register apps
Delete apps
Sort

4. On the apps list, select the app that you want to sort
Sort

CANON iMAGE GATEWAY

Picasa Web Albums

»» Note

« Description of displayed icons

: Cannot be used because it is not yet released or does not support your region, model, or
language.

n : Can be used with genuine Canon ink.

5. Use 4 / ¥ buttons to move the app

58



® CREATIVE PARK PREMIUM
Iy paper craft

b 8

6. Select Done

- ® CREATIVE PARK PREMIUM
¥ paper craft

b 2

Sorting is complete.
To continue the sorting, repeat the procedure from step 4.
To end the sorting, select Back and return to the cloud's Main screen.
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Using PIXMA/MAXIFY Cloud Link

This section introduces the photo printing procedure by using CANON iMAGE GATEWAY as an example.

3% Important

» The available functions differ depending on the app.

» The printing procedure differs depending on the app.

* You need to get the account and register photo and other data beforehand.

» The following file formats can be printed: jpg, jpeg, pdf, docx, doc, xlsx, xls, pptx, ppt, and rtf.
The file formats that can be printed differ depending on the app.

» Before you print, check that printer is on and is connected to the network. Then start.

»» Note

* You can use CANON iMAGE GATEWAY to print jpg and jpeg file formats.

1. On the Main screen, select the app to be used

2. Enter the information according to the instructions on the authentication screen, and then
select Log in

Country/Region:

Japan
User ID

Password

2% Important

« Some apps may not be fully displayed in the display area. If this is the case, scroll up, down, right,
and left to change the display area.

: Visible area

» The Login screen may vary between apps.

 After logging in, you may be asked from an external service to agree to use their app. Agree if you
are using the app.

3. In the displayed album list, select the album of your choice
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T
Sample00

%- Sample0
e

" " -j Sample?

Henu

4. In the displayed image list, select the image that you want to print, and then select Next

5. Make the necessary print settings, and then select Color

A message that indicates the completion of issuing print job appears, and printing starts.

Selected : 1

L 3.5"%x5"(89x127mm)

Media type  Plus Glossy ||

Print guality  Standard

To continue printing, select Continue, and perform the operation from Step 3.

To end the printing, select Apps. The screen returns to the apps list screen.

The print data has been sent.

Continue

Apps

32 Important

« If a print job is not printed within 24 hours after the print job is issued, the print job will expire and cannot
be printed.

» With premium apps that limit the number of print jobs, print jobs that cannot be printed due to expiration
and other reasons are also included in the print count.
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»» Note

» To leave a usage history of this service, from the Home window on the operation panel, select m
-

\

-

Setup -> =8 Web service setup -> Web service connection setup -> IJ Cloud Printing Center
setup -> History setting for this service -> Save.

= Cloud Troubleshooting
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Cloud Windows

This section describes the Main screen of Cloud and the services available on the Main screen.

32 Important

» Select how to manage allows you to change which users can use this service.
For details, see "Canon Inkjet Cloud Printing Center window".

When you select Cloud from the printer home screen, the cloud's Main screen appears.

You can use the areas shown below to perform various functions, including adding, starting, and managing

apps.
You can also print photos and documents by starting the appropriate app.

ICARIOR

CANON iIMAGE GATEWAY

Picasa Web Albums

E OneDrive

Add/delete ETER
(2) (3)

(1) Applications
(2) Add/delete button

(3) Manage button
22 Important

» Depending on the apps you plan to use, you may need to have an account beforehand. If this is the
case, get an account for each of those apps.

+ After selecting the app, some apps may not be fully displayed in the display area. If this is the case,
scroll up, down, right, and left to change the display area.

I : Visible area

« If an app is not yet released or does not support your model, language, or region, you will not be able to
start that app.

(1) Applications

Immediately after the cloud's Main screen appears, a list of the registered apps appears.
To start an app, select the app that you want to use on the list.
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> Note

» Description of displayed icons

: Cannot be used because it is not yet released or does not support your region, model, or
language.

n : Can be used with genuine Canon ink.

(2) Add/delete button

Use this button to add, delete, and sort apps.

Register apps

Delete apps

Sort

Register apps

Select this to add your favorite apps.

= See here for details on how to add apps

Delete apps

Select this to delete registered apps.

= See here for details on how to delete apps

Sort
Select this to sort the apps list.

= See here for details on how to sort the apps list

(3) Manage button

Use this button to manage jobs, log out of an app, show the license agreement and privacy statement,
and set the time zone.

Manage jobs
Settings

Legal information

Log out of all apps

Manage jobs

From the Status list window, you can check the status of a job.
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Settings

Select this to set the Time zone.
Select your region on the list. For some regions, you can set whether or not to apply the daylight saving
time setting.

32 Important

« If you cannot find your region on the list, select the one closest to your region.

Legal information

This shows the License agreement and Privacy statement.
Press the Start button to print the displayed information.

Log out of all apps

You can log out at the same time from all apps that you are logged into.

»» Note

» Some apps may keep you logged in even after the app ends. Therefore if you want to log in again
with a different account, select Log out of all apps to log out first.
» Once you log out, you need to log in again. You may lose the settings with some apps.
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Cloud Troubleshooting

If you cannot print

Check the following if you cannot print.

» Check that the printer is connected to the Internet.
» Check that the printer is connected to a LAN and the LAN environment is connected to the Internet.
» Check that no error message is displayed on the printer's LCD monitor.

« If printing does not start even after you wait awhile, go to the printer's home screen, and select m
Setup -> Web service inquiry.

If the problem is not resolved, use the printer driver from your computer to perform the print job and check
whether the data can be printed normally on the printer.
If you still cannot print, see the troubleshooting page for your model on the Home of the Online Manual.

»>» Note

» With a wireless LAN connection, after the printer is turned on, it may take several minutes before
communication is possible. Check that your printer is connected to the wireless network, and wait a
while before you start printing.

« If the printer is not turned on or is not connected to the Internet, and consequently a print job is not
processed within 24 hours after it was submitted, the print job is automatically canceled. If this
happens, check the printer power and the Internet connection, and then re-submit the print job.
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Using PIXMA/MAXIFY Cloud Link from Your Smartphone, Tablet, or
Computer

» Before Using Canon Inkjet Cloud Printing Center

¥

Registering User Information to Canon Inkjet Cloud Printing Center

¥

Using Canon Inkjet Cloud Printing Center

¥

Adding a Printer

¥

Adding a PIXMA/MAXIFY Cloud Link User

¥

Troubleshooting Canon Inkjet Cloud Printing Center
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Before Using Canon Inkjet Cloud Printing Center

Canon Inkjet Cloud Printing Center is a service that links with the cloud function of the printer and allows you
to perform operations such as registering and managing apps from your smartphone or tablet device, and
checking the print status, print error, and ink status of the printer. You can also print app photos and
documents from your smartphone or tablet.

First, check the following content:

* Precautions

If you plan to use the web service to print documents, be sure to check these precautions beforehand.

* Printer specification
Check that Canon Inkjet Cloud Printing Center supports the printer.
Some models do not support this function. To check whether your model supports this function, see
"Models that Support Canon Inkjet Cloud Printing Center".

* Network environment

The printer must be connected to a LAN and to the Internet.

32 Important

» The user will bear the cost of Internet access.

» Operating requirements
For computers, smartphones, and tablet devices, see "Requirements for Canon Inkjet Cloud Printing
Center operation".

22 Important

* This service may not be available in certain countries or regions. Also even if the service is available,
there are apps that cannot be used in certain regions.

= Registering User Information to Canon Inkjet Cloud Printing Center
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Requirements for Canon Inkjet Cloud Printing Center operation

Computer
CPU x86 or x64 1.6 GHz or higher
RAM 2 GB or higher

Resolution 1024 x 768 pixels or higher

Monitor displa
Y Number of display colors 24 bits (true-color) or higher

oS Browser

Internet Explorer 9
Windows Vista SP1 or later Mozilla Firefox
Google Chrome

Internet Explorer 9, 10, 11
Windows 7 Mozilla Firefox
Google Chrome

Internet Explorer 10, 11
Windows 8 Mozilla Firefox
Google Chrome

Internet Explorer 11
Windows 8.1 Mozilla Firefox
Google Chrome

Mac OS X v10.6-OS X Mavericks v10.10 | Safari 5.1, 6, 7, 8

Smartphone or tablet

(01 Browser Resolution
iOS 6.1 or later 320 x 480 (HVGA) or higher
OS standard browser
Android 2.3.3 or later 480 x 800 (HVGA) or higher

*Android3.x is not supported.

The operation requirements may change without prior notice. If this happens, you may no longer be able to
use this service from your computer, smartphone, or tablet.

3% Important

» On the browser you are using, enable JavaScript and cookies.
* If you use the zoom function or change the font size on your browser, the web pages may not display
correctly.

* If you use the translation function of Google Chrome, the web pages may not display correctly.

» The service does not support the use of its provided services through a proxy server outside of your
country.

* In an in-house network environment, the 5222 port must be released. For confirmation instructions,
contact the network administrator.
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Registering User Information to Canon Inkjet Cloud Printing Center

To use the Canon Inkjet Cloud Printing Center, you need to follow the steps described below and register
My account information.

= |f your model has color LCD monitor
= |f your model has monochrome LCD monitor
= |f your model has no LCD monitor
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Registering User Information to Canon Inkjet Cloud Printing Center
(Color LCD Monitor)

To use the Canon Inkjet Cloud Printing Center, you need to follow the steps described below and register
My account information.

Registering from Printer

1. Check that the printer is connected to the Internet

2. From the printer home screen, select Cloud

If printer information has not been registered to the cloud service server, the Registration Preparation
Completion Screen appears.

3. From cloud main screen, select Use from Smartphone or Mobile Integration Guide

Mobile Integration
Guide
.
q Scan to E-mail

WASE  CANON iMAGE GATEWAY

Add/delete Manage

4. Follow instructions appearing in screen, and select Next

5. In user registration screen, select Show QR Code

You can also access the URL manually from you smartphone, tablet, or computer.

Access the URL below from a
smartphone or tablet to perform
user registration.

cl-ev1.c-ij.com/join/ZV 3UPX
¥ Show QR Code

Copyright
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To return to the cloud main screen, select Exit.

»» Note

* You must have a special app to read QR codes from your smartphone or tablet. If you do not
have an app that reads QR codes on your smartphone or tablet, install one from App Store or
Google Play.

. In Preparation for registration screen, select Send blank e-mail

Preparation for registration

As praparation for registralion, send a
blank e-mail. Whean yoL end blank
e-mail], a blank e-mail will be sent o this
service and an e-mail containing the URL
for completing the registration work will be
sant to your e-mail addrass later.

If you want lo register with a different e-
mail address th he one set on the e-
mail client, select [Do not send].

Mote that the e-mail for completing the
registration work will be sent from
"noreply@mail.cs.c-ij.com". If you use e-
mail filters, be sure to allow a-mail from
this address.

Send blank e-mail

Do not send

»» Note

* When you select Send blank e-mail, the "destination entry completed" mailer starts up
automatically.
After the blank e-mail is created, send that e-mail without making any changes.

If you want to register a different e-mail address, select Do not send to display the E-mail address
entry screen.
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Preparation for registration

Enter the e-mail address you want to
register below, then select [Continue
regisiration].

* will be sant
ail

E-mail address:

Continue registration

In the displayed screen, enter the E-mail address that you want to register, and then select Continue
registration.

»» Note

* If you enter an e-mail address that has already been registered, you will receive an "already
registered" e-mail. Follow the instructions in the e-mail, and register a different e-mail address.

3% Important

* There are character restrictions for the e-mail address, as shown below.

« Up to 255 characters consisting of single-byte alphanumeric characters and symbols (!$"/
A f~.-@). (Uppercase and lowercase letters are differentiated.)

» Multibyte characters cannot be used.
You will get an error if the e-mail address you enter contains a character that cannot be
used.

« If you registered a different e-mail address by mistake, you can cancel the registration by going
to the printer's Home screen and selecting Setup -> Web service setup -> Web service
connection setup -> IJ Cloud Printing Center setup -> Delete from this service.

* You may not be able to receive the notification if you are using a spam filter. If you have a
setting to receive only the e-mails from certain domains, be sure to change the setting to allow
receiving e-mails from "noreply@mail.cs.c-ij.com".

There will be no error display even if you could not receive the e-mail because of the spam filter
setting or if you entered an incorrect e-mail address.

8. Check that you received blank e-mail, and then select Yes

73



Preparation for registration

Did the e-mail client start automatically,
and was a blank e-mail sent? If it was
sant, select "Yes".

If it was not sent, select "No”.

9. Follow instructions in screen display, and select OK

The registration page URL will be sent to the registered e-mail address.

Preparation for registration

Accepted the registration work. An e-mail
for completing the registration work will be
sent to the entered e-mail address.
Receive the e-mail and continue with the
registration work.

Access the URL in the e-mail, Register the Information, and Complete the
User Registration

1. Check that e-mail containing URL has been sent to registered e-mail address, and

access URL

2. In the License agreement and Privacy statement windows of Canon Inkjet Cloud
Printing Center, read the statements, and select Agree if you agree
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License agreement

- |
Impartant: Please read this before using
this service

Service Terms of Use

These Service Terms of Use (the "Terms")
are a binding agreement between you and
Canon Ine. (" an™) which govern your
use of the " " defined in Article 1
hereof offerad

You may agree to the Terms by

"Agree". Your use of the Service

be deemed as agreement to the Terms.
you do not agree to the Terms, you may
not use the Service,

Canon reserves the right to modify the
Terms at any time at its sole discretion.

hikamn tha Tarmme ars meadilad Maman

Do not agree Agree

Privacy statement

: =
Impaortant: Please read this before using
this service

Privacy Statement

This Privacy Statement (the "Privacy
Statement”™) describes informatiol ;
Canon Ine. ("Canon®) collects from w:

of the rvice” defined in Article 1 hareo
throughout the world (subject to certain
exceptions) and how this information is
usaed and disclosed.

By using the Service, you expressly agree
to the collection, use and disclosure of
information as described in the Privacy
Statement and Service Terms of Use (the
"Terms"). If you do not to the terms

Al e By tatamramt Ar tha Tarme

Do not agree Agree

3. Register password for logging in to Canon Inkjet Cloud Printing Center

In the My account registration screen, enter the password you want to register into Password and
Password (Confirmation), and then select Next.
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Register My account

Set a password for logging into this

Password (Confirmation):

8 to 32 characlars

Cancel

3% Important

* There are character restrictions for the Password, as shown below.

» The password must be between 8 and 32 characters long, using single-byte alphanumeric
characters and symbols (I"#$%&'()*+,-./;;<=>?@[¥]*_*{|}~). (Alphabets are case-sensitive)

4. Enter Nickname

Enter any user name you want to use.
Register My account
Mickname:

1 to 20 characlars

Time zone:

(UTC) Coordinated Universal Time i

2% Important

» The user name entry field has the following character restrictions:

* The user name must be between 1 and 20 characters long, using single-byte alphanumeric
characters and symbols ("#$%&'()*+,-./:;<=>?@[¥]*_*{[}~). (Alphabets are case-sensitive)
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5. Specify the Time zone setting, and select Done

Select your region on the list. If you cannot find your region on the list, select the one closest to your
region.
Apply daylight saving time
This appears only when there is a daylight saving time in the Time zone that you selected.
Select whether or not to apply the daylight saving time.

Register My account

Mickname:

1 o 20 characlars

Time zone:

The registration is complete. A registration completion message is displayed.
When you select the OK button in the message, the login screen is displayed.

Canon IJ Cloud Printing Center

E-mail address:

Password:

Keeap login info

Log in

Reset password from here

Create new account

About this service

Enter the registered E-mail address and Password, and Log in to the Canon Inkjet Cloud Printing
Center.

= Using Canon Inkjet Cloud Printing Center
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Registering User Information to Canon Inkjet Cloud Printing Center
(Monochrome LCD Monitor)

To use the Canon Inkjet Cloud Printing Center, you need to follow the steps described below and register
My account information.

Print registration information from the printer

1. On the printer operation panel, select the m Setup button, and then select Web
service setup -> Connection setup -> [JCloudPrintingCtr -> Register w/ service

2. In the registration confirmation window, Select Yes
[ i '?

3. In the print settings, select the display language

Language to print
L] English .

4. Follow the instructions displayed in the window, and print the URL of the authentication
site and the Printer registration ID

Set A4 size or Letter size or Legal size plain paper and select OK.
The authentication URL and Printer registration ID are printed.

32 Important

» The operation to complete the registration should be done within 60 minutes.

Access the URL on the printed page, and then enter the e-mail address and
other necessary information

32 Important

» Do not use the Back button of the web browser while an operation is processing. The screen may not

transition properly.

»>» Note

+ If you enter an e-mail address that has already been registered, you will receive an "already
registered" e-mail. Follow the instructions in the e-mail, and register a different e-mail address.

1. Use the web browser on your PC, smartphone, tablet, or other devices to access the
authentication URL
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. When the printer registration screen is displayed, select Create new account
Canon IJ Cloud Printing Center

E-mail address:

Password:

Keap login info

Login

Reset password from hare

Create new account

About this service

. Enter the E-mail address and Printer registration ID of the printer's owner, and then
select OK

The registration page URL is sent to the e-mail address entered.
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22 Important

* There are character restrictions for the e-mail address, as shown below.

 Up to 255 characters consisting of single-byte alphanumeric characters and symbols (!$'/
A fi~.-@). (Uppercase and lowercase letters are differentiated.)

» Multibyte characters cannot be used.
You will get an error if the e-mail address you enter contains a character that cannot be
used.

« If you registered a different e-mail address by mistake, you can cancel the registration by
selecting the Setup button on the printer operation panel, and then selecting Web service
setup -> Connection setup -> IJCloudPrintingCtr -> Delete from service.

* You may not be able to receive the notification if you are using a spam filter. If you have a
setting to receive only the e-mails from certain domains, be sure to change the setting to allow
receiving e-mails from "noreply@mail.cs.c-ijj.com"”.

There will be no error display even if you could not receive the e-mail because of the spam filter
setting or if you entered an incorrect e-mail address.

Access the URL in the e-mail, Register the Information, and Complete the
User Registration

1. Check that e-mail containing URL has been sent to entered e-mail address, and access
URL

2. In the License agreement and Privacy statement windows of Canon Inkjet Cloud
Printing Center, read the statements, and select Agree if you agree
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License agreement

- |
Impartant: Please read this before using
this service

Service Terms of Use

These Service Terms of Use (the "Terms")
are a binding agreement between you and
Canon Ine. (" an™) which govern your
use of the " " defined in Article 1
hereof offerad

You may agree to the Terms by

"Agree". Your use of the Service

be deemed as agreement to the Terms.
you do not agree to the Terms, you may
not use the Service,

Canon reserves the right to modify the
Terms at any time at its sole discretion.

hikamn tha Tarmme ars meadilad Maman

Do not agree Agree

Privacy statement

: =
Impaortant: Please read this before using
this service

Privacy Statement

This Privacy Statement (the "Privacy
Statement”™) describes informatiol ;
Canon Ine. ("Canon®) collects from w:

of the rvice” defined in Article 1 hareo
throughout the world (subject to certain
exceptions) and how this information is
usaed and disclosed.

By using the Service, you expressly agree
to the collection, use and disclosure of
information as described in the Privacy
Statement and Service Terms of Use (the
"Terms"). If you do not to the terms

Al e By tatamramt Ar tha Tarme

Do not agree Agree

3. Register password for logging in to Canon Inkjet Cloud Printing Center

In the My account registration screen, enter the password you want to register into Password and
Password (Confirmation), and then select Next.
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Register My account

Set a password for logging into this

Password (Confirmation):

8 to 32 characlars

Cancel

3% Important

* There are character restrictions for the Password, as shown below.

» The password must be between 8 and 32 characters long, using single-byte alphanumeric
characters and symbols (I"#$%&'()*+,-./;;<=>?@[¥]*_*{|}~). (Alphabets are case-sensitive)

4. Enter Nickname

Enter any user name you want to use.
Register My account
Mickname:

1 to 20 characlars

Time zone:

(UTC) Coordinated Universal Time i

2% Important

» The user name entry field has the following character restrictions:

* The user name must be between 1 and 20 characters long, using single-byte alphanumeric
characters and symbols ("#$%&'()*+,-./:;<=>?@[¥]*_*{[}~). (Alphabets are case-sensitive)
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5. Specify the Time zone setting, and select Done

Select your region on the list. If you cannot find your region on the list, select the one closest to your
region.
Apply daylight saving time
This appears only when there is a daylight saving time in the Time zone that you selected.
Select whether or not to apply the daylight saving time.

Register My account

Mickname:

1 o 20 characlars

Time zone:

The registration is complete. A registration completion message is displayed.
When you select the OK button in the message, the login screen is displayed.

Canon IJ Cloud Printing Center

E-mail address:

Password:

Keeap login info

Log in

Reset password from here

Create new account

About this service

Enter the registered E-mail address and Password, and Log in to the Canon Inkjet Cloud Printing
Center.

= Using Canon Inkjet Cloud Printing Center
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Printing Your Printer Registration ID

32 Important

+ Some models do not support this function.

To add a printer by using Canon Inkjet Cloud Printing Center, you will need a Printer registration ID.

From the operation panel of this printer, print the URL of the authentication site and your Printer

registration ID. The procedure is as follows:

1. Check that the printer is connected to the Internet

3% Important

» To use this function, you must connect this printer to the Internet.

If your model has color LCD monitor

2. From the home window, select m Setup -> Web service setup -> Web

service connection setup -> IJ Cloud Printing Center setup -> Register with this

service

3. In the registration confirmation window, Select Yes

Register this printer with
[} Cloud Printing Center?

4. In the print settings, select the display language

Language for print settings
HAE
English

Deutsch

francais

italiann

If your model has monochrome LCD monitor

2. On the printer operation panel, select the m Setup button, and then select Web
service setup -> Connection setup -> IJCloudPrintingCtr -> Register w/ service
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3. In the registration confirmation window, Select Yes

I i '?
< Yes >| Mo

4. In the print settings, select the display language

Language to print
L English L

5. Follow the instructions displayed in the window, and print the URL of the authentication site
and your Printer registration ID
When you set A4 size or Letter size or Legal size plain paper and select OK, the authentication site URL

and your Printer registration ID are printed.

32 Important

» The operation to complete the registration should be done within 60 minutes.
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Registering User Information to Canon Inkjet Cloud Printing Center
(No LCD Monitor)

To use the Canon Inkjet Cloud Printing Center, you need to follow the steps described below and register
My account information.

Registering from Your Smartphone, Tablet, or Computer

1. Check that the printer is connected to the Internet

22 Important

» To use this function, you must connect this printer to the Internet.

2. Displaying Printer Information

For details, go to the Online Manual home page, and see "Checking Printer Information" for your
model.

3. Select IJ Cloud Printing Center setup -> Register with this service
4. Follow the instructions displayed in the window, and run the authentication

5. When the Preparation for registration screen appears, select Send blank e-mail

Preparation for registration

As praparation for registration, send a
blank e-mail. When you select [Send blank
e-mail], a blank e-mail will be sent to this
service and an e-mail containing the URL
for completing the registration work will be
sant to your e-mail address later.

If you want o register with a different e-
mail address than the oene set on the e-
mail client, select [Do not send].

Note that the e-mail for completing the

on work will be sent fram
"noreply @mail.cs.c-ij.com”. If you use a-
mail filters, be sure to allow e-mail from
this address.

Send blank e-mail

Do not send

»» Note

* When you select Send blank e-mail, the "destination entry completed" mailer starts up
automatically.
After the blank e-mail is created, send that e-mail without making any changes.

If you want to register a different e-mail address, select Do not send to display the E-mail address
entry screen.
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Preparation for registration

Enter the e-mail add you want to
register below, then select [Continue
registration].

E-mail address:

Continue registration

In the displayed screen, enter the E-mail address that you want to register, and then select Continue
registration.

»» Note

* If you enter an e-mail address that has already been registered, you will receive an "already
registered" e-mail. Follow the instructions in the e-mail, and register a different e-mail address.

3% Important

* There are character restrictions for the e-mail address, as shown below.

« Up to 255 characters consisting of single-byte alphanumeric characters and symbols (!$"/
A f~.-@). (Uppercase and lowercase letters are differentiated.)

» Multibyte characters cannot be used.
You will get an error if the e-mail address you enter contains a character that cannot be
used.

« If you registered a different e-mail address by mistake, you can cancel the registration by
Displaying Printer Information and selecting IJ Cloud Printing Center setup -> Delete from
this service.

To display printer information, go to the Online Manual home page, and see "Checking Printer
Information” for your model.

* You may not be able to receive the notification if you are using a spam filter. If you have a
setting to receive only the e-mails from certain domains, be sure to change the setting to allow
receiving e-mails from "noreply@mail.cs.c-ij.com".

There will be no error display even if you could not receive the e-mail because of the spam filter
setting or if you entered an incorrect e-mail address.

6. Check that you received blank e-mail, and then select Yes
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Preparation for registration

Did the e-mail client start automatically,
and was a blank e-mail sent? If it was
sant, select "Yes".

If it was not sent, select "No”.

7. Follow instructions in screen display, and select OK

The registration page URL will be sent to the registered e-mail address.

Preparation for registration

Accepted the registration work. An e-mail
for completing the registration work will be
sent to the entered e-mail address.
Receive the e-mail and continue with the
registration work.

Access the URL in the e-mail, Register the Information, and Complete the
User Registration

1. Check that e-mail containing URL has been sent to registered e-mail address, and

access URL

2. In the License agreement and Privacy statement windows of Canon Inkjet Cloud
Printing Center, read the statements, and select Agree if you agree
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License agreement

- |
Impartant: Please read this before using
this service

Service Terms of Use

These Service Terms of Use (the "Terms")
are a binding agreement between you and
Canon Ine. (" an™) which govern your
use of the " " defined in Article 1
hereof offerad

You may agree to the Terms by

"Agree". Your use of the Service

be deemed as agreement to the Terms.
you do not agree to the Terms, you may
not use the Service,

Canon reserves the right to modify the
Terms at any time at its sole discretion.

hikamn tha Tarmme ars meadilad Maman

Do not agree Agree

Privacy statement

: =
Impaortant: Please read this before using
this service

Privacy Statement

This Privacy Statement (the "Privacy
Statement”™) describes informatiol ;
Canon Ine. ("Canon®) collects from w:

of the rvice” defined in Article 1 hareo
throughout the world (subject to certain
exceptions) and how this information is
usaed and disclosed.

By using the Service, you expressly agree
to the collection, use and disclosure of
information as described in the Privacy
Statement and Service Terms of Use (the
"Terms"). If you do not to the terms

Al e By tatamramt Ar tha Tarme

Do not agree Agree

3. Register password for logging in to Canon Inkjet Cloud Printing Center

In the My account registration screen, enter the password you want to register into Password and
Password (Confirmation), and then select Next.
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Register My account

Set a password for logging into this

Password (Confirmation):

8 to 32 characlars

Cancel

3% Important

* There are character restrictions for the Password, as shown below.

» The password must be between 8 and 32 characters long, using single-byte alphanumeric
characters and symbols (I"#$%&'()*+,-./;;<=>?@[¥]*_*{|}~). (Alphabets are case-sensitive)

4. Enter Nickname

Enter any user name you want to use.
Register My account
Mickname:

1 to 20 characlars

Time zone:

(UTC) Coordinated Universal Time i

2% Important

» The user name entry field has the following character restrictions:

* The user name must be between 1 and 20 characters long, using single-byte alphanumeric
characters and symbols ("#$%&'()*+,-./:;<=>?@[¥]*_*{[}~). (Alphabets are case-sensitive)
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5. Specify the Time zone setting, and select Done

Select your region on the list. If you cannot find your region on the list, select the one closest to your
region.
Apply daylight saving time
This appears only when there is a daylight saving time in the Time zone that you selected.
Select whether or not to apply the daylight saving time.

Register My account

Mickname:

1 o 20 characlars

Time zone:

The registration is complete. A registration completion message is displayed.
When you select the OK button in the message, the login screen is displayed.

Canon IJ Cloud Printing Center

E-mail address:

Password:

Keeap login info

Log in

Reset password from here

Create new account

About this service

Enter the registered E-mail address and Password, and Log in to the Canon Inkjet Cloud Printing
Center.

= Using Canon Inkjet Cloud Printing Center
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Using Canon Inkjet Cloud Printing Center

When the user registration is completed, you can log in to the Canon Inkjet Cloud Printing Center and use
the service.

1. From your PC, smartphone, or tablet, access the service login URL (http://cs.c-ij.com/)

2. On the Login screen, enter the E-mail address and Password, and then select Log in

3% Important

* The e-mail address and password are case-sensitive. Make sure the case is correct.

Canon IJ Cloud Printing Center

E-mail address:

Password:

Keep login info

Login

Reset password from here

Create new account

About this sarvice

E-mail address
Enter the e-mail address that you entered in the user registration.

Password
Enter the password that you entered in the user registration.

Keep login info
When you select the check box, the login screen is skipped for 14 days since the last day that the
service screen was accessed.

32 Important

« If you fail to log in five straight times, you will not be able to login again for about the next 60 minutes.

* You remain logged in for 60 minutes after the last access.

» The service may not function properly if you log in by using the same e-mail address from multiple
devices at the same time.

After logging in, you can use useful services such as adding/managing apps that work in conjunction with
this product's cloud functionality and checking the ink status.

For screen descriptions and operation instructions, see "Canon Inkjet Cloud Printing Center window".

Printing procedure

This section introduces the photo printing procedure by using CANON iMAGE GATEWAY as an example.
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32 Important

» The available functions differ depending on the app.

» The printing procedure differs depending on the app.

* You need to get the account and register photo and other data beforehand.

» The following file formats can be printed: jpg, jpeg, pdf, docx, doc, xlIsx, xlIs, pptx, ppt, and rtf.
The file formats that can be printed differ depending on the app.

» Before you print, check that printer is on and is connected to the network. Then start.

« This is available if you are using a smartphone or tablet.

»» Note

* You can use CANON iMAGE GATEWAY to print jpg and jpeg file formats.

1. On the Main screen, select the app to be used

2. Enter the information according to the instructions on the authentication screen, and then
select Log in

Country/Region:

Japan

User ID

Password

Cancel

3. In the displayed album list, select the album of your choice
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5. Make the necessary print settings, and then select Print
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4 Print settings

.+ EEERL N -
i o

Selected : 5
Paper size Letter
Media type Plus Glossy Il
Print quality Standard
Border Borderless
Photo fix ON |

Red-EveCorrection

Print

6. A print job completion message appears, and printing starts

The print data has been sent.

Continue

To continue printing, select Continue, and perform the operation from Step 3.
To end the printing, select Apps. The screen returns to the apps list screen.

32 Important

« If a print job is not printed within 24 hours after the print job is issued, the print job will expire and
cannot be printed.

» With premium apps that limit the number of print jobs, print jobs that expire and cannot be printed are
also included in the print count.

= Adding a Printer
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Canon Inkjet Cloud Printing Center window

This section describes the Canon Inkjet Cloud Printing Center screens that are displayed on your
smartphone, tablet device, or computer.

= Description of the Login screen
= Description of the Main screen

Description of the Login screen

This section provides the description of the Login screen of Canon Inkjet Cloud Printing Center.

Canon IJ Cloud Printing Center

E-mail address:

Password:

Keeap login info

Login

Reset password from here

Create new account

About this service

22 Important

* You have 5 tries to enter your password. If you fail, you will not be able to log in for about the next 60
minutes.
* You remain logged in for 60 minutes after the last access.

Language
Select the language you will be using.

E-mail address
Enter the e-mail address that you entered in the user registration.

32 Important

* The e-mail address is case-sensitive. Make sure the case is correct.

Password
Enter the password that you entered in the user registration.

Keep login info
When you select the check box, the login screen is skipped for 14 days since the last day that the

service screen was accessed.

Reset password from here
Select this if you forgot the password.
Reset your password by following the instructions on the screen.
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Create new account
A new registration will be added to the Canon Inkjet Cloud Printing Center.
For a new registration, you need the Printer registration ID.

About this service
This displays the descriptions of this service.

System requirements
This displays the system requirements for the Canon Inkjet Cloud Printing Center.

Software license info
The licensing information of Canon Inkjet Cloud Printing Center is displayed.

Description of the Main screen

When you log in to the Canon Inkjet Cloud Printing Center, the Main screen appears.
If you are using a smartphone or a tablet, you can also print photos and documents.

32 Important

» With this service, the available functions differ depending on whether the user is the Administrator
or Standard user of the printer, and also on the management method that was set.

You can use areas shown below to start, add, and manage apps.

(1)(2) _(3) (4)

series

[ EDE

]
Scan to E-mail

Facebook

Photos in Tweets

Evearnote

(1) Left context menu (Administrator only)
(2) Select printer

(3) Printer name area

(4) Right context menu

(5) Display area
(6) Menu area
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(1) Left context menu (Administrator only)

When you select E the left context menu appears.
When you select Mng. printer, Manage users, Group management, or Advanced management, the
corresponding screen appears.

»>» Note

» Group management appears only when you use Select how to manage and set Manage by group
(for office users).

Mng. printer screen

Mng. printer

Updaled dale: Mar 3, 2014 2:30 AM
SEres
Multiuser mode

Copy apps #

+ Add printer

From the Mng. printer screen, you can check or update printer information registered to the Canon
Inkjet Cloud Printing Center, copy apps, change printer names, delete printers, and add printers.

* Check the printer information
series
Multiuser mode

Copy apps

The registered printer name is displayed.

indicates that an error occurred on the printer.
 Display update date/time of the printer information
Mng. printer
Updated date: Mar 3, 2014 2:30 AM

SEries

Multiuser mode

Copy apps
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This displays the date and time the printer information was last updated.

refreshes the information.

Multiuser mode (MAXIFY series only)

If multiple users will be using the printer, add a check mark to Multiuser mode.
The check mark is linked to the Require security code screen.

Copy apps

Select this to copy apps added in the selected printer to another printer.

When you select , the screen shown below appears.

Copy registered apps to another
printer.

® Deslination printer:

Source printer:

series

Set the Destination printer and the Source printer. Then select OK.

»» Note

« If Select how to manage has been set, you can use this function only when you select
Manage app availability by printer.
For details, see "Tips on Using Canon Inkjet Cloud Printing Center (at Work)".

Change the printer name

When you select , a screen to change the printer name appears.
Follow the instructions on the screen to change the name.

22 Important

» The printer name entry has the following character limitation:

» Up to 128 characters (Uppercase and lowercase letters are differentiated.)

Delete printers

When you select , the printer is deleted from the Canon Inkjet Cloud Printing Center.
When transferring the ownership of the printer, select Clear the information saved on the printer.

Add printers

Multiuser mode

Copy apps 4

+ Add printer
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Select this to add printers to be used in the Canon Inkjet Cloud Printing Center.
You need a Printer registration ID to add a printer.

»» Note

+ Although the number of printers that can be registered for one domain is not limited, only up to
16 printers are guaranteed to operate.

Manage users screen

Eel Manage users =

Updated date: Feb 3, 2015 1:28 AM n

Delete

Mickname Authority

Administrator

Standard user

+ Add user

Close

From the Manage users screen, you can check user information registered to the Canon Inkjet Cloud
Printing Center, delete users, add users, and change the Administrator and Standard user settings.

* User deletion
Select the check box of the user to be deleted, and select Delete.
However, you cannot delete yourself. To delete yourself, cancel your membership from the My
account screen.

+ Adding a user

Select Add user. The user registration screen appears.

+ Changing Administrator and Standard user settings

To change the privileges of the Administrator or a Standard user, select Authority for the user
whom you want to change the settings for.
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Group management screen

ﬂ- Group management

About group management

graupi

Settings

+ Add group

Apps available on printers that do fj
not require a security code '

Settings

From the Group management screen, you can use functions for checking group information registered
to Canon Inkjet Cloud Printing Center, changing groups, deleting groups, adding groups, and setting up
users, printers, and apps belonging to each group.

* Checking group information

groupi

Settings

+ Add group

The registered group names appear.

If there are items that have not been set, appears.

Select
group.

to display the following screen, which allows you to set up information for each

The displayed information changes depending on the selected tab.

101



H Users

Displays all users and mail addresses registered in the domain.

E Printers

Displays all printers registered in the domain.

Apps

With the default settings, the screen displays all apps. To display only registered apps, select
the Registered category.

To switch between app registration/deletion, select / .

E Web services
Displays the external link service.
You can restrict the use of other web services that use Canon Inkjet Cloud Printing Center
accounts such as Easy-PhotoPrint+.

To switch between service linking/release, select / .

appears for items that do not have anything selected.
In the default settings, all check marks are cleared for Printers and Users. Only the system apps
under Apps are set to ON.

* Changing a Group name

To display the Group name change screen, select .
You can change the name to one of your liking by following the instructions in the displayed screen.

32 Important

* When you enter a Group name, the following restrictions apply:

* When using single-byte alphanumeric characters, enter at least 1 but not more than 20
characters. When using double-byte characters, enter at least 1 but not more than 10
characters.

» Duplicate group names cannot be registered in the same domain.
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* Deleting a Group

To delete a group from Canon Inkjet Cloud Printing Center, select .
If you delete all groups, you must create a new one. To set a different management method, set the
target method from the Select how to manage screen.

« Add group

groupi

Settings

=+ Add group

Add a group to be used in Canon Inkjet Cloud Printing Center.
»>» Note

* You can register up to 20 groups.

* Apps available on printers that do not require a security code

Apps available on printers that do fj
not require a security code '

Settings

For printers without the Multiuser mode setting or Security code settings, set the apps to be

displayed when a user selects Cloud from the printer's home screen.

If the domain does not have a printer that meets this condition, this setup screen does not appear.

To go to the setup screen, select m

»» Note

+ If only the following printer is registered in the domain, it is not displayed.

* Printer without LCD monitor
* Printer with monochrome LCD monitor
* Multiuser mode printer
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Advanced management screen

-I,',I- Advanced management

You can set how to manage printer users
and app availability.
See manual for details

Require securily code

Wou can re
requiring a

t how to manage
gcl how o manage apps and

printars.

Set

The Advanced management screen allows you to set the management method for printer users and
apps that can be used.

To go to the setup screen, select .

* Require security code

¥+  Advanced management

glect the printer(s) you want to require a
security code for
See manual

¥You cannot select models for which the
setting cannot be changed.

Each user can set a Security code, start the app, and perform printing and other operations.
This setting is linked with Multiuser mode on the Mng. printer screen.

»» Note

» The list does not display models without an LCD or models with a monochrome LCD.
» The check box does not appear for models that do not support Multiuser mode.
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+ Select how to manage

¥¥  Advanced management

Manage app availability by printer
® Manage app availability by user

Manage by group (for office users)
- Set applprinter availability by group -

Cancel

You can change the management method for usable apps and printers.

Manage app availability by printer
If you are using multiple printers, you can manage the useable apps for each printer.

Manage app availability by user
When one printer is used, you can manage the usable apps by user.
For usage examples, see "Tips on Using Canon Inkjet Cloud Printing Center (at Home)".

Manage by group (for office users)
You can manage the usable apps and printers by group.
For usage examples, see "Tips on Using Canon Inkjet Cloud Printing Center (at Work)".

»» Note

+ If you manage the usable apps by printer, the default settings will allow all users to add, delete,
and rearrange apps.
Also, if you are using a MAXIFY series printer and you select Multiuser mode in the Mng.
printer screen, only the administrator will be able to add, delete, and rearrange apps.

* If you manage the usable apps by user, all users will be able to add, delete, and rearrange
apps, regardless of the Multiuser mode setting.

« If you manage the usable apps and printers by group, all users will only be able to rearrange

apps.

(2) Select printer

Select E and then from the Select printer screen, select a printer.
If you are using a computer, you can select a printer directly from the pull-down menu.

»» Note

* Printers with settings that restrict their use do not appear.

(3) Printer name area

The registered name of the printer selected is displayed.
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The Administrator can change the printer name from the Mng. printer screen of the left context menu.

(4) Right context menu

When you select , the context menu appears.
The information displayed depends on the menu currently selected in the menu area.

The symbol indicates that there is a new unread notice.

saeries

Latest notices

E My account

Helpflagal notices

[
Log out

Evernote

" Photos in Tweets

Pra prtins Manage jols

This displays the screen to sort registered apps.

You can use the El El buttons to change the display order of apps. When you finish sorting, select
Done.
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Dropbox

Evernote

Facebook

Google Drive

»>» Note

» Description of displayed icons

: Cannot be used because it is not yet released or does not support your region, model, or
language.

u : Can be used with genuine Canon ink.

Latest notices

Latest notices

This displays the latest notices. The (i) symbol indicates that there is a new unread notice.

My account

My account

Displays user information.
From the My account screen, you can change your account settings.
From the My account screen, you can display the Permitted services screen and clear any linked

service setting.

. Help/legal notices

The description of the Canon Inkjet Cloud Printing Center screen and various reminders are
displayed.

This opens the Log out screen of the Canon Inkjet Cloud Printing Center.

(5) Display area

The display changes based on the menu you select.
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series

Instagram

Scan to E-mail

Facebook

Photos in Tweets

Evearnote

% =5 ®

AppS Condig Proparies

(6) Menu area

The following 4 menu buttons are displayed:

. Apps Apps

This displays the list of registered apps in the Display area.

-1
+ I Config

This displays the Register apps screen in the Display area.
The display can be toggled between Registered and Search apps.

The Registered screen lists registered apps.
You can check the information of these apps or deregister them.

»» Note

* If Group management has been set, Config is not displayed.
+ If Manage app availability by user has been set, even Standard user can register and delete

apps.
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LF = series

Registered | Search apps

Instagram

UM CANON ING.

Scan to E-mail

CANON NG,
Facebook
CANCN INC.

Photos in Tweets

(]

Proparies Manag

On the Search apps screen, the apps that you can register by using the Canon Inkjet Cloud Printing
Center are displayed by category.

Rogestorod
Al
Photography
Productivity
Rogstered  Search apps

(.‘-rE::ﬁtiuﬂ:,'

Remate print manager
Cards
< OFF | CANOM ING.
Crafls
= ® scanto

Remote FIXUSMAXIFY
Forms

OFF| | CANDN INC.

g SlideShara

OFF | CANON NG,

ml CmnaMote

i—
e

o When you select , the details of the app are displayed.
When you select / , you can choose to register or unregister the app.
2> Note

» Description of displayed icons

: Cannot be used because it is not yet released or does not support your region, model,
or language.

n : Can be used with genuine Canon ink.
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®

WL Properties

This screen displays the status of the printer that is currently selected.
You can check how much ink is remaining or details about an error that occurred. You can also
access the ink purchasing site and the Online Manual.

32 Important

» The Properties displayed may differ from the actual status at the display time, depending on the
printer status.

il Manage jobs

This screen displays the print or scan status and history.

You can check the print or scan status by looking at Status list, and the print or scan history by
looking at History.

You can also cancel print or scan jobs and delete history information.

To cancel or delete a job, select that job and then select Cancel or Delete.
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Tips on Using Canon Inkjet Cloud Printing Center (at Home)

The Advanced management function allows you to take advantage of the many useful functions that the
service offers for home use.
This section introduces those functions by using a family of 3 (father, mother, and child) as an example.

If the father registers the printer to Canon Inkjet Cloud Printing Center, only the father is managed by the
service, and the mother and the child cannot use the service unless the father tells them the login E-mail
address and Password.

If Mother and Child Want to Use the Service from Their Smartphones

1. The father registers to Canon Inkjet Cloud Printing Center and becomes the

Administrator

2. After logging in, the father selects Manage users from E‘ﬂ
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It =- series =

Mng. printer

Manage users

Advanced management

f Facebook

I " Photos in Tweets

U Evernote

i ®

Apps Config Proparties Manage johs

3. The father selects Add user, and by following the screen instructions, registers the
mother and child as users.

el Manage users

Updated date: Feb 3, 2015 1:29 AM

Delete

Nickname Authority

Administrator

+ Add user

After this registration is complete, the mother and child can individually use the service.

If Father, Mother, and Child Want to Manage Apps Individually
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With the default settings, only the Administrator (father) can register apps to be used or delete apps.
After the Administrator (father) specifies settings according to the procedure below, the father, the
mother, and the child will be able to manage apps individually.

1. As the Administrator, the father logs in to Canon Inkjet Cloud Printing Center and

selects Advanced management from E
geries —

Mng. printer
Manage users

Advanced management

Facebook

Photos in Tweets

Evernote

Gordig Propariies Manage johs

2. For Select how to manage, the father selects Set
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.;:1. Advanced management

You can set how to manage printer users
and app availability.
See manual for details

Require security code

Yiou can re k1] nexpecied

requiring a ( xnibry whien using ihis

sanvica from the aoperation panel.

Select how to manage

lect how 1o manage apps and

Set

3. The father sets Manage app availability by user and selects OK
{:I- Advanced management

Manage app availability by printer
® Manage app availability by user

Manage by group (for office users)
- Set app/printer availability by group -

Cancel

4. The screen for checking the management method change appears

In this mode, each user can freely set

In addition, recommended apps can

be used by default. Do you want to
change the setting?

Cancel 8] 4

To complete the setup and return to the Advanced management window, select OK.

All registered users can register and delete apps freely.
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Tips on Using Canon Inkjet Cloud Printing Center (at Work)

The Group management function allows you take advantage of the many useful functions that the service
offers for office use.

This section introduces an example in which two printers are used, the Administrator is the senior clerk,
and the other members are the company president, the section manager, and the new hire.

»» Note

+ If the second printer has not been registered, select "Adding a Printer" and register the printer by
following the procedure.

Creating a Group for All Office Members to Use

Set the basic group.
In this example, only the Evernote app will be used on 2 printers.

1. The senior clerk reqgisters to Canon Inkjet Cloud Printing Center and becomes the

Administrator

2. The senior clerk selects Manage users from E

Manage users

Advanced management

Facebook

| Photos in Tweets

U Evernote

f
)
&

iy ®

Apps Cordig Propariins Manage johs

3. On the displayed screen, the senior clerk selects Add user and registers the company
president, the section manager, and the new hire as users
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el Manage users =

Updated date: Feb 4, 2015 5:17 AM

Delete

Nickname Authority
Chief Administrator

+ Add user

4. The senior clerk selects Advanced management from E

=

-I:I- Manage users =3

Mng. printer

Advanced management

Mickname Authority

Chief Administrator

President Standard user

Manager Standard user

5. For Select how to manage, the senior clerk selects Set
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.;:1. Advanced management

You can set how to manage printer users
and app availability.
See manual for details

Require security code

You can n expecied
requiring a sec ry when u
sanvica from the aoperation panel.

¥ ect how 1o manage apps and
printars.

Set

6. The senior clerk sets Manage by group (for office users) and selects OK
ﬂ- Advanced management

Manage app availability by printer
Manage app availability by user

® Manage by group (for office users)
- Set app/printer availability by group -

Cancel

»» Note

+ If Group management has already been set up, refer to step 10 and the subsequent steps.

7. On the screen for checking management method changes, the senior clerk checks the
displayed information and selects OK.

In this mode, each user can freely set
their own app availability.
In addition, recommended apps can

be used by default. Do you want (o
change the setting?

Cancel
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The selting has been changed. The
setting screen for group
management will be displayed.

Set groups according to purpose.

OK

This appears only if the selected mode is Group management.
To complete the setup and display the Group management screen, select OK.

»» Note

+ With the default settings, the group is named "group1".
+ With the default settings, all registered users belong to the same group.

8. In the Group management screen, the senior clerk selects the of the group to be
renamed

9. The senior cler